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ABSTRACT 

Nowadays 3D printer has become a big challenge in technology of prototyping using 

the printer. This technology is not only used in industries of manufacturing but used for 

prototyping for an important constraint. This project is to develop low cost 3D printer 

but not only about the cost budget effective as output but the working process of the 3D 

printer. 

The output of this project expects to give benefit for the com_mon people with the 

effectiveness cost. 3D printing technologies are available to build a 3D object printing 

but this project aims to use the 3D manufacturing process that gives the effectiveness 

solution at low wastage of printing materials. The 3D printer capable of outputting in 

difference colours and different materials are already exist and will be continue to 

improve a point of functional product as output products. Now, 3D objects were bought 

from the online market and assemble the part of 3D printer. 

The original 3D printer is used as a reference for the actual position of components in 

3D printer. Learn about the 3D printer in spread and research the process from first step 

until finish used observation through Y ouTube, website and research paper. The 

modification of 3D printer made from wood to ensure cost lower. Using the 3D printer 

modified make the difference design through the CA TIA and Thinker cad and printing 

the product. To ensure the frame in the strength position the Finite element analysis 

used to simulate the process load that will be force at hot bed surface and frame using 

fiber wood. 

111 



ABSTRAK 

Pada masa kini pencetak 3D telah menjadi satu cabaran besar dalam teknologi prototaip 

menggunakan pencetak barangan. Teknologi ini hanya digunakan bukan sahaja dalam 

industri pembuatan tetapi digunakan untuk prototaip dengan keadaan penting. Projek ini 

adalah untuk pembangunan pencetak 3D kos rendah tetapi bukan sahaja tentang kos 

bajet berkesan sebagai pengeluaran object tetapi proses kerja pencetak 3D. 

Selepas projek ini mendapat sentuhan terakhir, ia akan memberi manfaat untuk rakyat 

biasa dengan keberkesanan kos. Teknologi percetakan 3D yang ada untuk membina 

sebuah percetakan objek 3D tetapi projek ini bertujuan untuk menggunakan proses 

pembuatan 3D yang memberi keberkesanan penyelesaian di pembaziran rendah bahan 

percetakan. Pencetak 3D mampu dikeluarkan dalam perbezaan warna dan bahan yang 

berbeza sudah wujud dan akan terus meningkatkan titik produk berfungsi sebagai 

pengeluaran produk. Sekarang, objek 3D telah dibeli dari pasaran dalam talian dan 

memasang bahagian pencetak 3D. 

Pencetak 3D digunakan sebagai rujukan untuk kedudukan sebenar setiap komponen 

dalam pencetak 3D. Belajar mengenai pencetak 3D dalam meluas melaui proses 

penyelidikan dari langkah pertama sehingga penamat menggunakan pemerhatian 

melalui Y ouTube, Iaman web dan kertas penyelidikan. Pengubahsuaian pencetak 3D 

diperbuat daripada kayu untuk memastikan kos yang lebih rendah. Menggunakan reka 

bentuk pencetak 3D yang diubah suaimembuat perbezaan melalui CATIA dan Thinker 

cad dan mencetak produk. Untuk memastikan rangka dalam kedudukan kekuatan unsur 

terhingga proses analisis yang digunakan untuk mensimulasikan beban yang akan 

menjadi kuasa di permukaan katil panas dan bingkai menggunakan gentian kayu. 
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CHAPTER1 

INTRODUCTION 

1.1 INTRODUCTION 

This chapter discusses about the introduction, concepts and overall ideas about 

low cost of 3D printer. Besides, the background of the project, problem statement, 

objective of the project, and the scope ofthe research will be described in detail in this 

chapter. 

1.2 BACKGROUND OF STUDY 

Everything around us such as toys, medical tools and buildings are designed can 

be created by 3D printing, making them a necessity in today's society. Toys companies 

are often referred to a new technology and the industry is commonly to fulfil the 

children and all of the age to ensure the products is suitable for different age. 

The toy industry is among the biggest beneficiaries of the technology in world. 

Toys have different type and design such as the toy action figures which is characters of 

every toy. Kids love the way that Action Figures can bring their favourites characters to 

life. Toys are already as tend to be small, different design and made out of plastic, 

making it easy to 3D print them. 

3D printing refers as process that used to synthesize a 3D object which 

successive layers-by-layer of filament or powder are formed using the computer 

control to create a 3D object or product. The objects produce in any shape or geometry 

and can be produced from digital model data 3D model or another electronic data 

source such as an Additive Manufacturing File (AMF) file. The term 3D printing has its 

1 
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origin sense 3D printing in reference to a process that deposits a binder material 

with inject heads layer by layer at one layer only one time. 

3D printing most commonly uses manufacturing industries to produce the 

product in small part. This printer can make simple process, to ensure the shape that we 

need able is processed. Using 3D printer can help to make the complete product and 

only need to produce using CA TIA and using 3D printer to print the small product base 

on the drawing. 

1.3 PROBLEM STATEMENT 

The cost to make one 3D printer machine is expensive and need to use a different 

filament to ensure the product is perfect. The cost to buy the machine 3D printer is 

higher for personal costumer. 

1.4 OBJECTIVE OF STUDY 

The research objectives are stated as follows: 

• To study the 3D printing process. 

• To develop the low cost of 3D printing. 

• To produce the 3D part using the 3D printing. 

1.5 SCOPE OF STUDY 

This project objective is narrowed down by performing scopes of study. 

• The project is development of low cost 3D printer. Need study about the process 

and assemble components of printer ensure full fill requirement of users and 

cost less than market prices. 

• The study will able to make assembly components of 3D printer for a period of 

FYP2. 

• The product by 3D printer able to be produced by CATIA and Thinker Cad 

software. 

2 



1.6 ORGANIZATION OF WRITING 

Thesis writing will be organized by show all the process flow that applied to 

complete the research, this flow will be discussed in details by listing and describing the 

chapters need in this thesis as follows: 

CHAPTER 1: INTRODUCTION AND GENERAL INFORMATION 

This chapter consists of: research background of 3D printing, problem 

statement, research objective, scope of research, data collection and how organization 

of waiting. 

CHAPTER 2: LITERATURE REVIEW 

This chapter about material that uses to producer that product of 3D printing, 

process of 3D printer, software, and process to convert the 3D cad into STL file. 

CHAPTER3:METHODOLOGY 

This chapter explains about flow 3D printer will make to ensure to develop the 

low cost, Gantt chart, budget plan and the expected outcome. 

CHAPTER 4: RESULT AND DISCUSSION 

This chapter explains about the result of data collected from 3D printer 

processed. Data analysis in this chapter using ANSYS to determine the load minimum 

and maximum from the 3D parts of printer. 

CHAPTER 5: CONCLUSION 

This chapter will summarize overall of project and recommendation future for printer 

parts information perform in 3D printer. 

3 
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CHAPTER2 

LITERATURE REVIEW 

2.1 INTRODUCTION 

This chapter describes some literature about 3D printer and the principle of 3D 

printer in general. All information related terms and terminology will be clearly stated. 

2.2 INFORMATION OF 3D PRINTER 

3D printer is fused deposition modelling (FDM) technique based on deposition 

of layer-by-layer of plastics ABS filament melting at extruded (Melocchi,2016). This 

3D printing is the process for manufacturing the object of three dimension and 

functional prototyping parts from the 3D drawing using CATIA or CAD software to 

producer the products (Sachs,l990). The 3D printer uses the ABS filament as the ink-jet 

to print the parts layer-by-layer and thick ofthe part product. 

2.2.1 3D PRINTER 

Three-dimensional (3D) printing is one of the revolution of the additive 

manufacturing techniques to create the 3D objects product with the unique structure 

and diverse properties (Weng,2016). There are various techniques to create using this 

machine such as Stereo lithography apparatus (SLA), fused deposition modeling (FDM), 

continuous liquid interface production (CLIP) and laser sintering (SLS) (Weng,2016). 

The Fused Deposition Modelling (FDM) technology it will work with production-grade 

thermoplastics or the Acrylonitrile Butadiene Styrene (ABS) to make the object or 

product to be stronger, more durable and dimensionally stable parts with the best 

accuracy, hardness, tough and repeatability of any 3D printing technology. Figure 2.1 

shows the example of 3D printer in market and Figure 2.2 shows the filament from 

4 



Acrylonitrile Butadiene Styrene (ABS). Figure 2.3 shows the process of 3D printer 

melting filament. 

Figure 2.1 Example of 3D printer 

(Sources: https://en.wikipedia.org/wiki/Fused deposition modeling ) 

Figure 2.2 Example of filament 

(Sources:https://www.alibaba.com/product-detail/Torwell-FDM-thermoplastics-ABS
PLA-Plastic 60105216284.html ) 

5 



The filament is 
normally 
into the 
block. This can 

present problems 
with less ridged 

filaments. 

A healer block melt. 
the Slament to a usable 

lernperahJre. Then the 
heated ~lament is 

extruded through the 
head af the printer. 

The bed often will move in the X and Y axes, 
and the extruder will move in the Z axis. 

Figure 2.3 Process flow ofFDM 

(Sources :http:/ /machinedesign.com/manufacturing -equipment/3d-printing-tips-and
tech-get-know-those-acronyms ) 

2.2.2 FDM technology work 

This FDM technology used as the model producing the 3D products by 

extruding the thermoplastics material or ABS filament to form the layer-to-layer as the 

material hardness after the extrusion from the nozzle (Kun,20 16). Plastics that used in 

this process will be melting from the nozzle after the extrusion, and will heat the 

filament from the coil and an extrusion will turn the flow on or off the surface ofthe top 

print plate. 

The print plate consists by two parts, one part called print bottom that mounted 

on the X-axis smooth rods that are as the base of the surface printed surface. The 

second part as the top print plate and the top print plate also need to use the heat bed 

mounted to remain on for the entire duration of the print. The filament hot and after the 

print and need the support to ensure no affects to the product. The nozzle of 3D printed 

controlled by the computer aided manufacturing (CAM) software that converts to the 

STL file and the layer-by-layer one layer at a time. The 3D printer by STL file move the 

extrusion head rely the object that produced. Figure 2.4 shows the 3D printer FDM 

process work from the filament to heated nozzle will be product. 
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The process of FDM technology: (http:/ /www.stratasys.com/3d-

printers/technologies/fdm-technology ) 

1. Pre-processing: Build-preparation software slices and positions of 3D product of 

figures using a 3D CAD file and convert to STL file to put in 3D printing and 

calculate a path to extrude thermoplastic and any necessary support material. 

2. Production: The 3D printer by extruded will heat the thermoplastic or ABS 

filament to a semi-liquid state to easily shape the figures and deposit it in ultra

fine beads along the extrusion path. Where support or buffering is needed, the 

3D printer deposits a removable material that acts as scaffolding. 

3. Post-processing: The user breaks away support material or dissolves it m 

detergent and water, and the part is ready to use. 

Fused Deposition Modeling (FDM) 

Ftlam~ml Ot-.ver 
(Extruder) 

Heated Nozzle --

Model 

Budd Platform 

Figure 2.4 FDM process work 

(Sources: https://www.printspace3d.com/cartesian-vs-delta-printers-work!) 

2.2.3 Applications 

a) Industrial printing 

In industry printing, this technology is used to create prototype designs in simple ways 

to ensure it has perfect design and also used for traditional manufacturing and research 

purposes, which is called Rapid Prototyping. 
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b) Medical Industry 

These technologies help the patients around the world able to experience improved 

quality of 3D printed implants and prosthetics like never before. 

c) Aerospace & aviation industries 

Develop metal additive manufacturing sector in larger boosted the utilization of 3D 

printing technology in the aerospace and aviation industries. 

d) Automotive industry 

This technology is used for building the durable concept models, prototypes, tool and 

low-volume end-use parts in-house, automotive designers and engineers can work more 

iteratively, test and move confidently into production. 

2.3 INFORMATION OF FILAMENT MATERIALS 

The filament used to produce 3D products need have the properties such as; 

high impact strength, great for mechanical parts fabrications, good post-printing, higher 

requirements on printing conditions, intended for industrial-grade 3D printers and 

smooth surface. 

2.3.1 Acrylonitrile Butadiene Styrene (ADS). 

Acrylonitrile Butadiene Styrene~ nanocomposite Witli -the organics modifieO 

montmorillonite (OMMT) was preparing by melt intercalation. The ABS filament for 

fused deposition modelling (FDM) 3D printings were produced by single screw extrude 

and will print by use 3D printer FDM. The FDM 3D printer is developed by S.Scott 

Crump in late 1980s and it will commercialized by Stratasys in 1990 (Weng,1990). The 

use of the FDM 3D printer will make the mechanical strength worse compared with 

injection moulding. 

The thermoplastics materials such as ABS filament, nylon, poly-lactic acid, and 

blends are used for FDM 3D printer as the filament. The used thermoplastics materials 

ensure the mechanical properties of the 3D printer thermoplastics and fibre reinforce 
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composite will be used. To help produce continuous and homogeneous filament the 

special additive may be necessary extruded. 

2.3.2 Poly-lactic acid (PLA) 

Poly-lactic (PLA) the popular thermoplastic for fused deposition modelling 

(FDM). Poly-lactic acid filament is the biodegradable polymer from the new resources. 

The process need to be carried out of 200°C above the temperature for melting the PLA 

filament. 

2.3.3 Filament melting 

Firstly, the acrylonitrile butadiene styrene (ABS) pellets and the different 

amount of the organics modified montmorillonite (OMMT) powder will physically 

mixed by the homogenizer and the process will continue after the mixture of the two 

ABS and OMMT mixed together using the twin screw extrude and the temperature to 

heat the filament must be 6 times from the chamber that is 200 oc from the funnel to the 

head of the extrusion head. FDM consists the deposition to build the plate from heat the 

extrusion move along the x and y axis and z direction while the lower of built and the 

heat ofhead extrusion and melted the filament (Melocchi,2016). 

By using the FDM 3D printer, there are two nozzles at the extrusion, first the 

one nozzle extrudes the construction material and the other extrudes material to support 

the incline surface to again the building direction (Galantucci,2015). The material 

support is to ensure the part that no bottom support can print and no defect to minimum 

excess of the filament. The head of the extruded move in x and y direction plane and the 

deposit of the material deposit according the geometry part use the SL T file of 3D 

drawing. 

In the FDM technology, the plastics filament works from the coil and the 

material of plastics filament flow into the extrusion nozzle, the nozzle will heat and 

melt the plastics and be moved in the x and y direction or horizontal and vertical 

direction by a numerically controlled using the computer aided manufacturing (CAM) 

software and convert to STL file to read in 3D printer. The product use the plastics and 
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extruding melted material to form the layer but only one layer process in one time as the 

material hardens immediately after the extrusion process from the extrusion nozzle. 

Figure 2.5 shows filament work from the filament will be heat in extrusion nozzle head 

become solid model. 

\~att:ra! Spool 

t 

Sol difted \1odel 

Figure 2.5 Filament work 

• 
Heated 
Extrusion 
Head 

1 Molten Material 

Platform 

(Sources: http:/ /www.theaxiz.com/3d-printing/3d-printing-processesD 

2.4 SOFTWARE AND PROCESS CONVERT CAD FILE TO STL FILE 

This STL format is used to describe the CAD geometry part to change other 

system that computer can read and performance to ensure the design will be same with 

the drawing use CAD part (Liu, 2017). In the general Stereo Lithography or STL file is 

format file that created of CAD software by 3D system. This STL file support by other 

software packages and used for rapid prototyping in 3D printer or CNC machine. 

2.4.1 STL FORMAT 

The STL file conceived by use 3D system is created from the database of via for 

interface the 3D CAD system. The file consists the unordered of every list of the 

triangular at every facets of surface and to represent the other outside skin of product to 

ensure the outside of skin is perfect (Junk,2016). The method is represented and 
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described the CAD geometry from the other system. STL file as facet model derived 

from the CAD and Thinker-Cad file drawing. 

2.4.2 ADVANTAGE AND DISADVANTAGE OF THE STL FILE 

The advantages of this file first one: it provides the simple method to represent 

three Dimensional CAD data. Second, this file is already use the standard of a de facto 

and this file is commonly used in the most of CAD system. Third, used the STL file 

contain and provide the small and accurate data file to transfer for STL file using the 

triangular facets (Chua, 2014). The disadvantages of this file is first: this STL file large 

than the CAD data file. Second, this file will carriage more redundant information, such 

as the edges and duplicates vertices. 

2.4.3 STL PROBLEM 

S TL problem that consists of the nature of S TL file as file contain no topological data. 

The type of error by following (Chua,2014): 

(i) Gaps (cracks, holes, punctures) missing the facets. 

• The error at the intersection between the surfaces, leaving gaps and 

the hole along the edges of the part of product. 

(ii) Degenerate faces (where all its edges are collinear). 

• When all the edges facets are collinear even through all the vertices 

are district. --- - - -- -- --------- - - ---- -

(iii)Overlapping facets 

• Generated represent in 3D but cause the facets to overlap if 

tolerances are set too liberally. 

(iv)Non-manifold topology conditions 

STL solution 

• Three type of non-manifold namely; a non-manifold edge, non

manifold point and non-manifold face. 

(i) Generic solution 

I. Solve the missing facets problem 

II. Solve the wrong orientation of facets 

11 



-- ---- ~~--- -~ - ~ -----------------~ -- -- ---- ------------------~-- - - --~------------------- --

2.4.4 CONVERT SOLID MODEL TO STL FILE 

Convert the 3D drawing to STL file first, by using the 3D modelling drawing 

created using the computer aided design (CAD) software package for example 

AutoCAD, CATIA, Solid work and the other different of software. Second, the CAD 

model is converted into STL (Standard Tessellation Language) file format. The file can 

translate the 3D model into a collection of triangular facets to easily to 3D printer read. 

If necessary, some adjustments are carried out to 3D printing and build the real model. 

For example, if we convert 3D drawing used CATL4 to STLfile. The procedures: 

Save CAT Product files as CAT Part Files for 3D printing: 

1. File Menu> Open > source file selected imported CAT Product file save 

2. Select File > New> Part >Name the new part 

3. Select one component from your master CAT Product File and copy it 

4. Component paste in a new part window 

5. Repeat steps and until you have copied all 

6. Select File> New Part 

7. Individual component copy 

8. The new part ready to exported as an STL file 

9. Select Tools> Generate CAT Part from Product 
"- - ... --"- -----· 

10. Select File > Save as type: STL 

2.5 CATIA SOFTWARE 

3D CAD advance in modelling to general prerequisite rapid prototyping processes 

usually the time-consuming part mostly of the entire process chain. One key that need 

to use the CATIA in design that makes the analysis to carry out product modelling, 

management, state control, and assembly based on design product structure (Li,2013). 

This CA TIA commonly as 3D Product Lifecycle Management software suite, CATIA 

supports multiple stages of product development, including conceptualization, design 

(CAD), engineering (CAE) and manufacturing (CAM). CATIA facilitates collaborative 

engineering across disciplines around its 3D experience platform, including surfacing & 
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shape design, electrical fluid & electronics systems design, mechanical 

engineering and systems engineering. 

3D printer, process for the industries in manufacture of tooling and functional 

prototyping parts using the direct computer modelling using CATIA software. 3D 

printing function by deposition the filament will melting in extruded in layers and 

performed the product. The process uses PLA filament as the ink in order to build the 

product. 

2.5.1 ADVANTAGE OF CATIA 

• Simple to reference and reuse exist 3D and 2D drawing data. 

• New concepts in 3D can be quickly generated from existing 2D layouts. 

• Faster to build the products by using CATIA. 

• Full product can be reviewed by using multiple views from side, front, top 

and bottom. 

• Manufacturing and other downstream activities benefit from direct 

integration and access to the full 3D product definition. 

• Downstream users can create their own specialized views and Improve 

decision making with accurate data. 

• On-demand blueprint creation allows documentation to be easily produced 

for the extended enterprise. 

2.6 DESIGN 3D PRINTING EXISTING (REP RAP) 

RepRap is the humanity's first for the general purpose to build by self

replicating of manufacturing machine. From the RepRap website shows how to make 

the simple ways by used the all material to make the 3D printer step by step. The 

materials and other components can buy used online and it freely available for the 

benefit of everyone. In RepRap at RepRap.org is the space that community to ask the 

question about the machine that means to welcome to edit most pages on that site. The 

reference website RepRap: (http://reprap.orgD. Figure 2.6 and Figure 2.7 shows the 

market design of 3D printer. 
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Figure 2.6 Example of exist 3D printer 

(Source: https://al13dp.comlhistory-of-the-reprap-proj ect/ ) 

Figure 2. 7 Example of exist 3D printer 

(Source: http://shop.prusa3d.com/en/3d-printers ) 
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CHAPTER3 

METHODOLOGY 

3.1 INTRODUCTION 

In this chapter, strategy and the methods to make the low cost 3D printer will be 

explained. The aim for this chapter as the technique to ensure that the methods of 3D 

printing to assembly will be perfect and the analysis use the flow chart till the end of the 

project. The material used to replace plastic for frame 3D printer is composite wood or 

fiber because the cost buy the material is cheaper than plastics cost. The composite 

woods contain the other materials such as wood fiber and some type of binding agent. 

These ingredients are put together to form a material that is denser, stronger, and 

heavier than wood alone. The existing cheap Reprap 3D printer (pursa i3) buys after 

compare the price with other 3D printer market and cost to buy each component 

separate is higher. The 3D printer modification is less the price because the frame that 

use from the wood is lower cost than other materials. 
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3.2 PROCESS PLANNING FLOWCHART 

Figure 3.1 Process of flowchart 

BACKGROUND PROJECT, 
PROBLEM STATEMENT, 

IDENTIFY THE OBJECTIVE 

MODIFIED 3D PRINTER 

END 

Figure 3.1 shows the process planning flowchart of 3D printer from the Final year 

project 1 and 2. 
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3.3 ASSEMBLY 3D PRINTER SETUP 

3D printer can produce a lot of parts and also the 3D printer has higher cost. 

So, used the assembly 3D printer will make the cost lower and can buy the cheap part 

after make the survey from different market. The output quality of 3D printer will be 

the same with the market but we build our own with reference from the original 3D 

printer. 

3.3.1 COMPONENTS OF 3D PRINTER 

Main component in 3D printer part that use depends on the type of project. The 

melting of the nozzle is important in 3D printer because the filament need melting at 

200-230°C make the product. Figure 3.2 show the list and part of 3D components. 

3.3.1.1 FRAME 

The frame consists with the threaded rods with connected together with the 

printed part called as the vertices and the place to hold the printed part and controlled 

the y-axis and z-axis. 

3.3.1.2 Y-AXIS AND BUSHING 

Y axis control by a belt attached to a stepper motor with the pulley. The pulley 

will control by the motor and y a.Xis move at the bottom. 

Bushings is actually the plain bearing that will slide over smooth rods when move along 

the y axis and this bushing ensure no friction when the pulley pull the rods up or down. 

3.3.1.3 Z-AXIS AND X-AXIS 

The z-axis and y-axis are the part to move up down and right or left move. This 

axis is the part of the construction. 
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3.3.1.4 EXTRUDER 

This extruder consists of two parts, the top part or cold part that feed the 

filament of plastics. The bottom part or the hot place, that will melt and extruder the 

plastics to become the other objects it depend the design. 

X- Carriage can be use the bushing or linear bearing. This x carriage controls 

the motor and the belt. 

3.3.1.6 PRINT PLATE 

The x, y and z axis move together to build the product so will move the nozzle 

above the plate and the finish product by 3D printer will cold at print plate. 

This plate actually consist the two plates, first bottom print plate that mounted as the 

x-axis smooth rods use the bushing or the linear bearing. The top print plate is a 

mounted on x-axis and to form the finish product or as the print surface. 

3.3.1. 7 ELECTRONICS PART 

The electronics board connected with the Personal Computer (PC) by the USB-

.·· to;;serial converted~ ·other-llra:ti; use the Atdliino · With the-RAMPS board such as tlie ··- · -

converter build-in. 

3.3.1.8 STEPPER MOTOR 

There are five stepper motor in build 3D printer: 

• To control they axis 

• To control the x axis 

• To control the z axis (2 motor) 

• To control extruded 
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3.3.1.9 FILAMENT 

• ABS Filament 

• PLA Filament 

Illustration: 
1. X-Axis motor 
2. Main control board 
3. Z-Axis screw motor 
4. Power supply 
5. Extrusion machine motor 
6. Extrusion head 
7. Print platform 

Print platform spring 

Figure 3.2 List of components 

(Source: http://www.ebay.ca/itm/3D-Printer ) 
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3.3.2 ELECTRONIC PART 

Based those components mentioned in pervious part, there are some electronics 

components uses as shows in Figure 3.3 and Figure 3.4. 

Z-axls 
Stepper motor 

2nd Z·axis 
Stepper motor 
(Prusa) 

Figure 3.3 Boards with Minitronicsl.O 

X-axis 
Stepl>"r motor 

Figure 3.4 Boards with Minitronics2.0 

z-axls 
Stepper motor 

(Source:https://print3d.com.pk/wp-content/uploads/2015/09/Prusa-i3-Build

Manual. pdf) 
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3.4 SIMPLIFIED BLOCK DIAGRAM 

3D OBJECT DESIGN 

OUTPUT ON 
HOTPLATE 

CONVERSION TO 
RELEVANT CODE 

MECHANICAL 

WORKING 

Figure 3.5 Simplified block diagram 

3.5 BUILD 3D PRINTER 

INPUT TO 
ELECTRONICS 

DEVICES 

Assembly design of 3D printer is the process to reduce the assembly cost and 

the time taken to assembly the part. The assembly, act of combining component in the 

manufacturing makes the machine or product. Figure 3.6 to Figure 3.19 shows the 

components or parts to be used to build the 3D printer. 

Figure 3.6 Hold x-axis motor Figure 3.7 Stepper motor X-axis 
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Figure 3.8 Hold filament Figure 3.11 Stepper motor z-axis (2parts) 

Figure 3.12 Hold the feed rod z-axis 
Figure 3.9 Hold hot bed 

Figure 3.13 Frame of3D printer 
Figure 3.10 Stepper motor y axis 
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Figure 3.14 Pulley to hold the belt y-axis Figure 3.16 LCD red boards 

Figure 3.15 Extruder nozzle Figure 3.17 Main board 

Figure 3.18 Hot bed Figure 3.19 Assemble component 
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CHAPTER4 

RESULTS AND DISCUSSION 

4.1 INTRODUCTION 

This chapter will discuss the result of the study and presented the results of the 

3D printer build. This chapter will also show the information and the data that analyse 

and discuss. 

4.2 DATA COLLECTION 

The data that collect after finish build the 3D printer and print the part to 

ensure the machine is function. The data information obtains from observation and 

pictures take during build the 3D printer. 

4.2.1 COMPARISON BETWEEN 3D PRINTER MARKETS 

The total price of 3D printer is less than RM131 0, price to make a 3D printer is 

cheaper than the market price refer to Figure 4.1 and Figure 4.2 market price and table 

4.1 for total cost of components. The frame used from wood to ensure the cost is less 

than the Perspex and metal. The advantage of wood is easily to shape, machining and 

assemble. The other components in 3D printer is used because the components were 

function such as motor to move the extruded and hot bed, power supply current, hot bed 

hold the product and fan for cool the extruded. To minimum the cost of 3D printer need 

to ensure the cost lower than market price. The frame change to fiber wood need 

replace to ensure the 3D printer strength and low cost. 
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6 Months International Seller Warranty more 

• Self-developed control system 
based on Mega2560+ Ramps 
1. 4~ paired with the A4982 driver 
chip running at main frequency 
50Hz.110V or 220V adjustable 
all these greatly improving the 
overall printing performance 

more 

ffJ SELLER PROMOliONS 

1 temp. sensor for replacement 

RM 1,660.00 
Before RM 1.69Q.GQ. 
Yousavel% 
Up to 12 months, as low as 
RM 138.33 per month. 

Figure 4.1 Market price of 3D printer (http:/ /www.lazada.com.myD 

3DGadgets 
Computer & Software " Hardw3re > Printer > General 
TEVO Black Widow 3D Printer 
DIYKit Latest Revision with ExternaiMOSFED 

Our Price 

Quanfity 

ttemiO 

Ship To 

RM 2,550.00 

RM 73 by courier to Peninsular Malaysia 
RM 206 by courier to Sabah, Labuan 
RM 180 by courier to Sarawak 
RM 400 by courier to Oversea 

From Cheras I Kuala lumpur , Estimated Arrival 1-3 working days. () 

201elt 

'A' Add to Cart 

• Ado to V"lshJ,st 171 

182410554 

W11hin Malaysia .Ship By: Courier Servtces Self Collect 

Figure 4.2 Market price 3D printer chttps:/ /www.lelong.com.my/) 
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Table 4.1 Price of components 

No. Component Quantity Price per unit Price 

Stepper motor 

1 ~~ - 4 RM89.90 RM359.60 

lJ 
~ 

Limit switch 

2 p 3 RM15.00 RM45.00 

<It 
LCD display 

3 1 RM69.00 RM69.00 

' 
Fan 

4 
~ 

1 RM22.00 RM22.00 

~ 

Head hot end 

5 1 RM79.00 RM79.00 
.,:· 

Rod 

6 4 6 RM5.00 RM30.00 

Lead screw rod 

7 / 2 RM21.50 RM49.00 

, 
Power supply 

8 1 RM100.00 RM100.00 
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9 1 RM40.00 RM40.00 

Hot bed 

10 1 RM80.00 RM80.00 

Belt 

11 

-
1 RM10.00 RM10.00 

Pulley 16 tenth 

12 1 RM14.00 RM14.00 

Flexible coupling 

13 2 RM20.00 RM40.00 

~, 

Ball bearing 

14 ::J>Godgets 7 RM7.00 RM49.00 

Control board 

15 1 RM180.00 RM180.00 

••••• 
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Spring 

16 3)Gadgeu 7 RM1.50 RM10.50 

I 
··trcro. 
~ - "?? .;::q 

Filament 

17 1 RM79.00 RM79.00 

~ 
18 Frame 1 

set RM50.00 RM50.00 

TOTAL COST RM1306.1 

The price of 3D printer is less than RM 1310 for the components that needed to 

build the 3D printer show in Table 4.1 Price of components. 

4.3 COMPARISON OF 3D PRINTER 

The original 3D printer is used as a reference for actual position of the part 

components in 3D printer. Figure 4.3 and Figure 4.4 is the 3D printer original and 

modified. 

Figure 4.3 Original 3D printer Pursa i3 
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4.3.1 Modified design 3D printer 

Wood 

Wood 

Wood 

Figure 4.4 Modified 3D printer. 

4.4 DRAWING OF 3D PART 

The 3D printer models that been scanned, design in CAD software and printer 

are requirement product. 

4.4.1 Drawing product "CATIA" 

Computer aided three-dimension interactive application or CA TIA is software 

that suitable for designing the drawing 3D product and develop the design to print in 3D 

printer after save as STL file. This software provides the advanced technologies to 

design the complex drawing to print. CA TIA enables the creation of 3D parts from the 

3D sketches to develop the 3D drawing. In this project, simple toys assembly is 

produced. Figure 4.5 Part 1 to Figure 4.9 Assemble part shows the design created in 

CATIA software. 
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Figure 4.5 Part 1 Figure 4.7Part 3 

Figure 4.8Part4 (2 pieces) 
Figure 4.6 Part 2 

13 CATIA V~ · 1Product1.CA1Produd:J - 0 X 

IJ ~rt ENOVIA VS VPM. £~ ldit ~iew inHrt !oob: ~ Wtndow l:l~ 

4 

Figure 4.9 Assemble part 
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4.4.2 Drawing product using Thinker cad 

Thinker cad is browser-based 3D design and modelling tool, easy to make 

perfect design with simple design in minutes. 3D designs that thinker cad can produce 

such as toys, prototypes, home decor figures, case phone and other. Thinker cad was 

founded by Kai Backman and Mikko Mononen in 2011 that can bring the first Brower

based 3D design in the platform. 

The thinker cad is easy to learn and incredible used for make the simple and 

complex design. The 3D modelling is the process to develop of any three-dimension 

surface of an object. It displays the two dimensional image to three dimensional. 3D 

modelling software is the 3D computer graphical software that used to produce the 3D 

models that can print through 3D printer. Figure 4.10 3D model thinker-cad bowser

based. show the design used the Thinker Cad software. 

Figure 4.10 3D model thinker-cad bowser-based. 

(Source: https:/ /www.tinkercad.com/) 
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4.5 PROCEDURE TO PRINT PRODUCT (REPETIER HOST) 

Repetier-Host works with almost all 3D FDM printers. Repetier-Host is easy to 

use for beginner to control the printer, slider and printing process. This software is easy 

multi-part printing in one time, can load duplicate of many models and print them 

simultaneously. Figure 4.11 to Figure 4.13 show the Repetier-host software to control 

the heat and motor of 3D printer. 

0 - ~-liiiil ,. ... 
CCIIMrt l ead. s-Pmt ~~11Pi."'t l:iitf:nr.t 

ltJ ~Fditr-HoltVT.il.6· raw pH 

Fih; .,.-_ Coni'ig Printtr Teoll Ht lp 

Figure 4.12 Inside part in Repetier-Host 
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eJ Re~·Hmvt.D.6- dcQgntO 

FileVitwCcnfigPrintHTCJCk~ 

Figure 4.13 Controller 3D printers. 

4.6 PRODUCT OF 3D PRINTING 

- 0 X 

Printinq...UE 2h:l:im:T3slayu l H /307 

3D printer allows faster innovations design and the manufacturing timing to 

produces product are shorter. 3D printer changes the face of products with easy to use 

online apps and software that people can create the unique product. In designing the toy 

need to put some ideas into the virtual files. Figure 4.14 to Figure 4.19 show the 

product printed of 3D printer. 

Figure 4.14 Model part 1 Figure 4.15 Model part 2 

33 



Figure 4.16 Model part 3 
Figure 4.18 Assemble part model 

Figure 4.17 Model part 4 
Figure 4.19 Tinker-Cad products. 

4.7 PATTERN INSIDE THE PRODUCT 

The printer uses that some patterns, that can be controlled Repetier-Host 

software to choose such as rectilinear, line, concentric, honeycomb, Hilbert curve 

(slow), Archimedean chords (slow), and actogram spiral (slow). Figure 4.20 shows the 

pattern controller and Figure 4.21 and Figure 4.22 show the design of pattern. 
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Figure 4.20 Fill pattern chose "Repetier-Host" 

Figure 4.21 Honeycomb Figure 4.22 Rectangle 
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4.8 ANSYS DATA 

ANSYS software with modular structure gives opportunity for taking only necessary 

features. ANSYS enables to simulate testing or working condition for test the product 

before virtual environment of manufacturing prototyping product. ANSYS imports the 

CAD design to igs file and enables to build the geometry preprocessing abilities. 

4.8.1 ANSYS hot bed plate 

ANSYS generally is a software that can be used to simulate interactions of all 

disciplines of structures, physics, vibration, fluid dynamics, load, heat transfer and 

electromagnetic for engineers. ANSYS load used to know the deformation for surface 

of hot bed plate and the min deformation occurs in middle and the max deformation 

ends of plate. Figure 4.23 shows the deformation by using ANSYS. So, 3D printer of 

product. will produces in the middle of plate because the minimum load. 

y 

~X 

Figure 4.23 ANSYS of hot bed plate. 
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4.8.2 ANSYS frame 

Frame holds all the components together. The frame made out of fiber wood. 

The minimum load for the frame occurs on bottom because support part and the 

maximum load above. Figure 4.24 shows the deformation of the fiber wood frame. 

1.8004 
1.5582 
1.3161 
1.074 
0.83184 
0.58971 
D.34758Min 

Figure 4.24ANSYS of frame 

0.000 

4.9 COMPARISON OF DIMENSION 

0.200 (m) 

0.100 

Comparison between dimensional actual products with design used CATIA software. 

Figure 4.25 and Figure 4.26 shows dimension of product and design. The tolerances 

mean amount of number that allowable amount of variation of a specified quantity, 

especially in the dimensions of the product. The CA TIA design dimensional 40 
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millimeter but after make the 3D printer for product the dimension is bigger 0.05 

millimeter from the design. The tolerance of product is +0.05 but accept because small 

than 1.0 millimeter. The cause effects of tolerance such as molten filament excessive, 

no support material and other. 

Figure 4.25 Actual dimensions Figure 4.26 Drawing dimension 
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CHAPTERS 

CONCLUSIONS 

5.1 INTRODUCTION 

In this chapter, conclusions from this study make based on the previous chapter 

and the recommendation suggested improving the performance in low cost 3D printer 

and 3D part produce. 

5.2 CONCLUSIONS 

1. The 3D printer process has been studied in this project. 3D printer process used 

Fused Deposition Modelling (FDM) technique by melting layer-by-layer of 

plastics filament at nozzle used temperature 200°C for Poly-lactic acid (PLA) 

filament. The type of filament used in FDM technique such as Poly-lactic acid 

and Acrylonitrile Butadiene Styrene heat difference temperature to melting the 

filament. 

2. Low cost of 3D printer has successfully been developed. The low cost of 3D 

printer is successful build by changing the material of frame. The frame made 

of the fibre wood is cheaper than aluminium or Perspex. 

3. 3D parts have been produced using low cost of 3D printing. The parts are 

designed using the CATIA and Thinker Cad and were printing using the low 

cost of 3D printer and the parts have successfully finish. The toys and assemble 

toys are produced using the printing. 

4. The finite element analysis (FEA) is the numerical method for solving problem 

of manufacturing product. The typical solving methods for this project include 

load for support the machine, structural analysis and the deposition force for 3D 

printer. 
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5.3 RECOMMENDATION 

Problem solving recommended in order overcoming the 3D printer work 

properly such as adjustable manual of nozzle extruded by touch the hot bed before 

make the printer because if the nozzle not touch the hot bed it not function and the 

printing are damaged. Before printer make sure the filament in the nozzle and 3D part 

can printing. The low cost of 3D printer is ensure the entire component to assemble are 

ready and the Board with Minitronics assemble correctly with wire ensure the current 

not explode. 
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APPENDIX A 

A2: GANTT CHART (Continued) 
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No. W4 I W5 I W6 I W7 I W8 I W9 IW10 IW111W121W13 IW14 
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7 lll<:UlL..~ and submit chapter 5 

8 poster 
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10 !Compile chapter 1,2,3,4, and 5 

11 !Submit checking 

12 I Submit hardbound 

Remark: Planned process Actual progress 
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APPENDIXB 

Bl: ANSYS DATA for hot plate 

1\NSYS 
Project 

Author NOR AZIRAH BINTI ARIFIN 
Subject HOT BED 

Prepared for FYP2 
First Saved Wednesday, May 31 , 2017 
Last Saved Wednesday, May 31,2017 

Product Version 15.0 Release 
Save Project Before Solution Yes 

Save Project After Solution Yes 

y 

0.000 0.100 (m) ~X 
0.050 
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2 Contents 

• Units 

• Model (A4) 
o Geometry 

• PartBody 
o Coordinate Systems 
o Mesh 
o Modal (AS) 

• Pre-Stress (None) 
• Analysis Settings 
• Solution (A6) 

• Solution Information 
• Results 

• Material Data 
o Structural Steel 

3 Units 

TABLE 1 
Unit System Metric (m, kg, N, s, V, A) Degrees rad/s Celsius 

Angle Degrees 
Rotational Velocity rad/s 

Temperature Celsius 
4 Model (A4) 

5 Geometry 

TABLE 2 
Model (A4) > Geometry 

Object Name Geometry 
State Fully Defined 

peflnition 
Source C:\Users\Acer-N B\Desktop\hot -bed. igs 

r-- - - ------- ---- -· ·· · ·---- ~ -~ --- +ype lgs 
Length Unit Meters 

Element Control Program Controlled 
Display Style Body Color 

- Boundil'!g Box 
Length X 0.254 m 
LengthY 0.235 m 
Length Z 3.e-003 m 

Properties 
Volume 1.7907e-004 m3 

Mass 0.48564 kg 
Scale Factor Value 1. 

Statistics 
Bodies 1 

Active Bodies 1 
Nodes 1618 

Elements 210 
Mesh Metric None 
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Basic Geometry Options 
Solid Bodies Yes 

Surface Bodies Yes 
Line Bodies No 
Parameters Yes 

Parameter Key DS 
Attributes No 

Named Selections No 
Material Properties No 

Advanced Geometry Options 
Use Associativity Yes 

Coordinate Systems No 
Reader Mode Saves Updated File No 

Use Instances Yes 
Smart CAD Update No 

Compare Parts On Update No 
Attach File Via Temp File Yes 

Temporary Directory C:\Users\Acer-NB\AppData\Locai\Temp 
Analysis Type 3-D 

Mixed Import Resolution None 
Decompose Disjoint Geometry Yes 

Enclosure and Symmetry Processing Yes 

TABLE 3 
Model (A4) > Geometry > Parts 

Object Name PartBody 
State Meshed 

Graphics Properties 
Visible Yes 

Transparency 1 
Definition 

Suppressed No 
Stiffness Behavior Flexible 

Coordinate System Default Coordinate System 
Reference-Temperature By Environment 

Material 
Assignment Structural Steel 

Nonlinear Effects Yes 
Thermal Strain Effects Yes 

Bounding Box 
Length X 0.254 m 
LengthY 0.235 m 
Length Z 3.e-003 m 

Properties 
Volume 1. 7907e-004 m3 

Mass 0.48564 kg 
Centroid X 0.127m 
Centroid Y 0.1175 m 
Centroid Z 1.5e-003 m 

Moment of Inertia lp1 2.2353e-003 kg·m 2 

Moment of Inertia lp2 2.6113e-003 kg·m2 

Moment of Inertia lp3 4.8459e-003 kg·m 2 
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Statistics 
Nodes 1618 

Elements 210 
Mesh Metric None 

6 Coordinate Systems 

7 Mesh 

TABLE4 
Mod I (A4) C d" t S t e > oor ma e iYS ems> oor mae ys C d" t S tern 

Object Name Global Coordinate System 
State Fully Defined 

Definition 
Type Cartesian 

Coordinate System ID 0. 
Origin 

Origin X 0. m 
Origin Y 0. m 
Origin Z 0. m 
Directional Vectors 

X Axis Data [1.0.0.] 
Y Axis Data [ 0. 1. 0.] 
Z Axis Data [ 0. 0. 1. 1 

TABLE 5 
Model (A4) > Mesh 

Object Name 
State 

Defaults 
Physics Preference 

Relevance 
Sizing 

Use Advanced Size Function 
Relevance Center 

Element Size 

Mesh 
Solved 

Mechanical 
0 

Off 
Coarse 
Default 

Initial Size Seed Active Assembly 
Smoothing Medium 
Transition Fast 

Span Angle Center Coarse 
Minimum Edge Length 3.e-003 m 

Inflation 
Use Automatic Inflation None 

Inflation Option Smooth Transition 
Transition Ratio 0.272 

Maximum Layers 5 
Growth Rate 1.2 

Inflation Algorithm Pre 
View Advanced Options No 
Patch Conforming Options 

Triangle Surface Mesher Program Controlled 
Patch Independent Options 
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T apology Checking Yes 
Advanced 

Number of CPUs for Parallel Part Meshing Program Controlled 
Shape Checking Standard Mechanical 

Element Midside Nodes Program Controlled 
Straight Sided Elements No 

Number of Retries Default (4) 
Extra Retries For Assembly Yes 

Rigid Body Behavior Dimensionally Reduced 
Mesh Morphing Disabled 
Defeaturing 

Pinch Tolerance Please Define 
Generate Pinch on Refresh No 

Automatic Mesh Based Defeaturing On 
Defeaturing Tolerance Default 

Statistics 
Nodes 1618 

Elements 210 
Mesh Metric None 

8 Modal (AS) 

TABLE 6 
Model (A4) > Analysis 

Object Name Modal (AS) 
State Solved 

Definition 
Physics Type Structural 

Analysis Type Modal 
Solver Target Mechanical APDL 

0Rtions 
Environment Temperature 22. oc 

Generate Input Only No 

TABLE 7 
Model (A4) > Modal (A5) > Initial Condition 

~ Object Namel Pre-Stress (None) 
State I Fully Defined 

Definition 
Pre-Stress Environment I None 

TABLE 8 
o e > o a > na ys1s e mgs M d I (A4) M d I (A5) A I . S tf 

Object Name I Analysis Settings 
State I Fully Defined 

0Rtions 
Max Modes to Find I 6 

Limit Search to Range I No 
Solver Controls 

Damped ! No 
Solver Type I Program Controlled 

Rotordynamics Controls .o..=.: 
Corio lis Effect I Off 

Campbell Diagram I Off 
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~' 
Output Controls 

Stress No 
Strain No 

Nodal Forces No 
Calculate Reactions No 

General Miscellaneous No 
Analysis Data Management 

C:\Users\Acer-

Solver Files Directory 
NB\AppData\Locai\Temp\WB_ACER_Acer-

NB_3800_3\unsaved_project_files\dp0\SYS\MEC 
H\ 

Future Analysis None 
Scratch Solver Files Directory 

Save MAPDL db No 
Delete Unneeded Files Yes 

Solver Units Active System 
Solver Unit System mks 

9 Solution (A6) 

TABLE 9 
Model (A4) > Modal (AS) > Solution 

Object Name I Solution (A6) 
State I Solved 

Adaptive Mesh Refinement 
Max Refinement Loops I 1. 

Refinement Depth I 2. 
Information 

Status I Done 

The following bar chart indicates the frequency at each calculated mode. 

FIGURE 1 
Model (A4) > Modal (AS) > Solution (A6) 
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TABLE10 
Model (A4) > Modal (AS) > Solution (A6) 

Mode Frequency [Hz] 
1. 
2. 0. 
3. 
4. 3.6581 e-003 
5. 4. 7968e-003 
6. 6.1244e-003 
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Total Deformation 

Subject: HOTBED 

Date Wednesday, May 31, 2017 

Comments: 

y 

0.000 ,lx 
0.050 
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APPENDIXB 

B2: ANSYS data of frame. 

10 Project 
Author NOR AZIRAH BT ARIFIN 

Subject FRAME 
Prepared for FYP2 
First Saved Wednesday, May 31,2017 
Last Saved Wednesday, May 31,2017 

Product Version 15.0 Release 
Save Project Before Solution Yes 

Save Project After Solution Yes 

-- ---------

z 

OUD 0.200(m) J:.x 
0.100 
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11 Contents 

• Units 

• Model (A4) 
0 Geometry 

• Part Body 
0 Coordinate Systems 
0 Mesh 
0 Modal (AS) 

• Pre-Stress (None) 
• Analysis Settings 
• Solution (A6) 

• Solution Information 
• Results 

• Material Data 
0 Structural Steel 

12 Units 

TABLE 1 
Unit System Metric (m, kg, N, s, V, A) Degrees rad/s Celsius 

Angle Degrees 
Rotational Velocity rad/s 

Temperature Celsius 
13 Model (A4) 

14 Geometry 

TABLE 2 
Model (A4) > Geometry 

Object Name Geometry 
State Fully Defined 

Definition 

Source 
C:\Users\Acer-N B\Desktop\ANSYS AZI RAH 

FYP2\frama.igs 
Type lges 

Length Unit Meters 
Element Control Program Controlled 

Display Style Body Color 
Bounding Box 

Length X 0.10947 m 
LengthY 0.372 m 
Length Z 0.378 m 

Properties 
Volume 8.9249e-004 m3 

Mass 0.44624 kg 
Scale Factor Value 1. 

Statistics 
Bodies 1 

Active Bodies 1 
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Nodes 1532 
Elements 614 

Mesh Metric None 
Basic Geometry Options 

Solid Bodies Yes 
Surface Bodies Yes 

Line Bodies No 
Parameters Yes 

Parameter Key DS 
Attributes No 

Named Selections No 
Material Properties No 

Advanced Geometry Options 
Use Associativity Yes 

Coordinate Systems No 
Reader Mode Saves Updated File No 

Use Instances Yes 
Smart CAD Update No 

Compare Parts On Update No 
Attach File Via Temp File Yes 

Temporary Directory C:\Users\Acer-N B\AppData\Local\ Temp 
Analysis Type 3-D 

Mixed Import Resolution None 
Decompose Disjoint Geometry Yes 

Enclosure and Symmetry Processing Yes 

TABLE 3 
Model (A4) > Geometry > Parts 

Object Name PartBody 
State Meshed 

Graphics Properties 
Visible Yes 

Transparency 1 
Definition 

----·.~--Suppressed No 
Stiffness Behavior Flexible 

Coordinate System Default Coordinate System 
Reference Temperature By Environment 

Material 
Assignment Structural Wood 

Nonlinear Effects Yes 
Thermal Strain Effects Yes 

Bounding Box 
Length X 0.10947 m 
LengthY 0.372 m 
Length Z 0.378 m 

Properties 
Volume 8.9249e-004 m3 

Mass 0.44624 kg 
Centroid X 9.1362e-003 m 
Centroid Y 0.18578 m 
Centroid Z 0.16765 m 

55 



Moment of Inertia lp1 1.7971e-002 kg·m 2 

Moment of Inertia lp2 9.747e-003 kg·m2 

Moment of Inertia lp3 8.3432e-003 kg·m 2 

Statistics 
Nodes 1532 

Elements 614 
Mesh Metric None 

15 Coordinate Systems 

16 Mesh 

TABLE4 
Mod I (A4) C d" S e > oor mate ;ystems > oor mate ;ys c d" S tern 

Object Name Global Coordinate System 
State Fully Defined 

Definition 
Type Cartesian 

Coordinate System ID 0. 
Origin 

Origin X 0. m 
Origin Y 0. m 
Origin Z 0. m 
Directional Vectors 

X Axis Data [ 1. 0. 0.] 
Y Axis Data [ 0. 1. 0. 1 
ZAxis Data [ 0. 0. 1.] 

TABLE 5 
Model (A4) > Mesh 

Object Name 
State 

Defaults 
Physics Preference 

Relevance 
Sizing 

Use Advanced Size Function 
Relevance Center 

Element Size 

Mesh 
Solved 

Mechanical 
0 

Off 
Coarse 
Default 

Initial Size Seed Active Assembly 
Smoothing Medium 
Transition Fast 

Span Angle Center Coarse 
Minimum Edge Length 3.186e-004 m 

Inflation 
Use Automatic Inflation None 

Inflation Option Smooth Transition 
Transition Ratio 0.272 

Maximum Layers 5 
Growth Rate 1.2 

Inflation Algorithm Pre 
View Advanced Options No 
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Patch Conforming Options 
Triangle Surface Mesher Program Controlled 

Patch Independent Options 
Topology Checking Yes 

Advanced 
Number of CPUs for Parallel Part Meshing Program Controlled 

Shape Checking Standard Mechanical 
Element Midside Nodes Program Controlled 
Straight Sided Elements No 

Number of Retries Default (4) 
Extra Retries For Assembly Yes 

Rigid Body Behavior Dimensionally Reduced 
Mesh Morphing Disabled 
Defeaturing 

Pinch Tolerance Please Define 
Generate Pinch on Refresh No 

Automatic Mesh Based Defeaturing On 
Defeaturing Tolerance Default 

Statistics 
Nodes 1532 

Elements 614 
Mesh Metric None 

17 Modal (AS) 

TABLE 6 
Model (A4) > Analysis 

Object Name Modal (AS) 
State Solved 

Definition 
Physics Type Structural 

Analysis Type Modal 
Solver Target Mechanical APDL 

Options 
Environment Temperature 22. oc 

Generate Input Only No 

TABLE 7 
Model (A4) > Modal (A5) > Initial Condition 

Object Name I Pre-Stress (None) 
State I Fully Defined 

Definition 
Pre-Stress Environment ! None 

TABLE 8 
o e > o a > nalySIS e mgs M d I (A4) M d I (A5) A I . S tf 

Object Name I Analysis Settings 
State I Fully Defined 

Options 
Max Modes to Find I 6 

Limit Search to Range I No 
Solver Controls 

Damped I No 
Solver Type I Program Controlled 
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Rotordynamics Controls 
Coriolis Effect Off 

Campbell Diagram Off 
Output Controls 

Stress No 
Strain No 

Nodal Forces No 
Calculate Reactions No 

General Miscellaneous No 
Analysis Data Management 

C:\Users\Acer-

Solver Files Directory 
N 8\AppData\Local\ T emp\WB_ACER_Acer-
NB_3856_2\unsaved_project_files\dp0\SYS 

\MECH\ 
Future Analysis None 

Scratch Solver Files Directory 
Save MAPDL db No 

Delete Unneeded Files Yes 
Solver Units Active System 

Solver Unit System mks 

18 Solution (A6) 

TABLE 9 
Model (A4) > Modal (AS) > Solution 

Object Name I Solution (A6) 
State I Solved 

Adaptive Mesh Refinement 
Max Refinement Loops I 1. 

Refinement Depth I 2. 
Information 

Status I Done 

The following bar chart indicates the frequency at each calculated mode. 

FIGURE 1 
Model (A4) > Modal (AS) > Solution (AS) 
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TABLE10 
Model (A4) > Modal (AS) > Solution (AS) 

Mode Frequency [Hz] 
1. 
2. 

0. 
3. 
4. 
5. 3.6578e-003 
6. 6.248e-003 
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Total Deformation 

Subject: FRAME 

Date Wednesday, May 31 , 2017 

Comments: 

1.9004 
1.5582 
1.3161 
1.074 
0.83184 
0.58971 
0.34758M'm 

0.000 

z 

0.200 (m) 
4:_.x 

0.100 
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Low Cost of 3D Printer 
Nor Azirah Arifin 

Fa13022 

Faculty of Manufacturing Engineering, FKP, University Malaysia Pahang, 
Kampus Pekan, 26~00 Pekan, Pahang Darul Makmur. 

noraziraharifin@gmail.com 

Abstract-Now a days 3D printer has become a big challenge in 
technology of prototyping using the printer. This technology is 
not only used in industries of manufacturing but used for 
prototyping for an important constraint. This project is to 
development of low cost 3D printer but not only about the cost 
budget effective as output but the working process of the 3D 
printer. 

After this project gets final touch it will benefit for the common 
people with the effectiveness cost. 3D printing technologies are 
available to build a 3D object printing but this project aims to use 
the 3D manufacturing process that gives the effectiveness solution 
at low wastage of printing materials. 

Index Terms-CATIA, 3D PRINTER, Thinker-cad. (key words) 

INTRODUCTION 

The toy industry is among the biggest beneficiaries of the 
technology in world. Toys has a different type and design such 
as the toy action figures is characters of every toys and kids 
will love the way that Action Figures can bring their favourites 
characters to life. Toys already as tend to be small, different 
design and made out of plastic, making it easy to 3D print them. 

Everything around us such as toy, medical tools and 
buildings are designed and created by 3D printing, making 
them a necessity in today's society. Toys companies are often 
referred to as new technology and the industry is commonly to 
fulfil the children and all of the age to ensure the products is 
suitable for different age. This technology such as modify, 
download, and share three-dimensional designs using software 
and convert using computer driven machines as making 3D 
drawing to adjust and embodiments of the designs. 

3D printing most common use in industries of 
manufacturing to produces the product in small part. This 
printer will make simple process to ensure the shape that we 
need it can process. Using 3D printer will help to make the 
complete produce and only need to produces using CATIA and 
using 3D printer to print the small product base on the drawing. 

61 

METHODOLOGY 

BACKGROUND PROJECT, 
PROBLEM STATEMENT, 

IDENTIFY THE OBJECTNE 

Figure 1.0 Flowchart of process 
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Figure 2. 0 Simplified block diagram process of 3D printer 

RESULTS AND DISCUSSION 

The result of the study and presented the results of the 3D 
printer build. 

COMPARISON BETWEEN 3D PRINTER MARKETS 

The total price of 3D printer less than RM1310, price to 
make a 3D printer is cheaper than the market price market price 
and table 4.1 for total cost of components. The frame used from 
wood to ensure the cost is less than the Perspex and metal. The 
advantage of wood is easily to shape, machining and assemble. 
The other components in 3D printer is used because the 
components were function such as motor to move the extruded 
and hot bed, power supply current, hot bed hold the product 
and fan for cool the extruded. To minimum the cost of 3D 
printer need ensure cost lowest than market price. Change the 
frame to wood will ensure the 3D printer strength and low cost. 

Figure 3. 0 Market p rice 
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Figure 4. 0 Market price 
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COMPARISON OF 3D PRINTER ORIGINAL AND 

MODIFIED 

Figure 5. 0 original p ursa i3 



Figure 6.0: Modifiedpursa i3 

The original 3D printer used as refer actual position of the part 
components in 3D printer. 

DRAWING OF JDPARTCATIA 

Computer aided three-dimension interactive application or 
CATIA, software that suitable for design the drawing 3D 
product and develop the design to print in 3D printer after save 
STL file. This software provides the advanced technologies to 
design the cDmplex drawing to print. CATIA enables the 
creation of 3D parts from the 3D sketches to develop the 3D 
drawing. In this project, simple toys assembly is provided. 
Assemble part show the design used CATIA software. 
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Figure 7.0: CATIA drawing 

DRAWING PRODUCT "THINKER CAD" 

Thinker cad browser-based 3D design and modelling 
tool, easy make perfect design with simple design in minutes 
and the imagine anything. 3D designs that thinker cad product 
such as toys, prototypes, home decor figures, case phone and 
other. Thinker cad was founded by Kai Backman and Mikko 
Mononen in 2011 that can bring the first Brower-based 3D 
design in the platform. 

Figure 8. 0: Thinkercad drawing 
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PROCEDURE TO PRINT PRODUCT (REPETIER HOST) 

Repetier-Host works with almost all 3D FDM printers. 
Repetier-Host is easy to use for beginner to control the printer, 
slider and printing process. This software is easy multi-part 
printing in one time, can load duplicate of many models and 
print them simultaneously. 

1!1 • ... ., .. -·- ·''·' .... _,.,..._--

Figure 9. 0 Repetier host software 

~ -·t.;S·- ... ........ ._ __ _ 

Figure I 0. 0 inside Part in Repetier host 

"'--VI.!J;- ....... l~ ... -c.-;-'-""" 

Figure 11. 0 Controller of Repetier host 

64 

PRODUCTOFJDPRINTING 

3D printer allows faster innovations design and the 
manufacturing timing to produces product are shorter. 
3D printer changes the face of products with easy to 
use online apps and software that people can create 
the unique product. In designing the toy need to put 
some ideas into the virtual files. 

Figure 12.0 example of product 3D printer 

PATTERN INSIDE THE PRODUCT 

The printer uses that some patterns, that can be 
controlled Repetier-Host software to choose such as 
rectilinear, line, concentric, honeycomb, Hilbert 
curve (slow), Archimedean chords (slow), and 
actogram spiral (slow). 

Figure 13.0 Honeycomb pattern 



Figure 14.0 Rectangular pattern 

ANSYS 

ANSYS hot bed plate- ANSYS load used to know the 
deformation for surface of hot bed plate and the min 
deformation occurs in middle and the max 
deformation ends of plate. 

Figure 15.0 Deformation of hot plate 

ANSY Frame- holds all the components together. 
The frame made out of fiber wood. The minimum 
load for the frame occurs on bottom because support 
part and the maximum load above. 

Figure 16.0 Deformation offrame 
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CONCLUSION 

The 3D printer process has been studied in this project. 3D 
printer process used Fused Deposition Modelling (FDM) 
technique by melting layer-by-layer of plastics filament at 
nozzle used temperature 200°C for Poly-lactic acid (PLA) 
filament. The type of filament used in FDM technique such as 
Poly-lactic acid and Acrylonitrile Butadiene Styrene heat 
difference temperature to melting the filament. 

Low cost of 3D printer has successfully been development. 
The process make 3D printer require patient because the 
components for 3D printer have lot of part and detail 
procedure to produce the capable machine work. The low cost 
of 3D printer successful by change the material of frame. The 
frame make from the fibre wood is cheaper than aluminium or 
Perspex. 

3D parts have produced using low cost of 3D printing. The 
parts have design using the CATIA and Thinker Cad were 
printing using the low cost of 3D printer and the parts 
successfully finish. The toys and assemble toys are produce 
using the printing. 

The finite element analysis (FEA) is the numerical method for 
solving problem of manufacturing product. The typical solving 
methods for this project include load for support the machine, 
structural analysis and the deposition force for 3D printer. 

RECOMMENDATION 

Problem solving recommended in order overcoming the 3D 
printer work properly such as adjustable manual of nozzle 
extruded by touch the hot bed before make the printer because 
if the nozzle not touch the hot bed it not function and the 
printing are damaged. Before printer make sure the :filament in 
the nozzle and 3D part can printing. The low cost of 3D 
printer is ensure the entire component to assemble are ready 
and the Board with Minitronics assemble correctly with wire 
ensure the current not explode. 
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